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Integration with EBICS Banking Server

IBM® Sterling File Gateway can integrate with the IBM Sterling B2B Integrator
EBICS server.

Sterling File Gateway provides secure file transfer between internal and external
partners using the same or different communication protocols, file naming
conventions, and file formats. Sterling File Gateway supports movement of large
and high-volume file transfers, with visibility of file movement in a
process-oriented and highly-scalable framework that alleviates file transfer
challenges, such as protocol and file brokering, automation, and data security.

Files move between the Sterling B2B Integrator EBICS server and Sterling File
Gateway using shared partners and mailboxes. The shared mailboxes are created
when EBICS partners are created. Sterling File Gateway then uses the mailboxes
for transferring files to or from EBICS partners.

For inbound scenarios, a partner uses an EBICS client to perform an EBICS order
file upload (FUL) to the Sterling B2B Integrator EBICS Server, which unpackages
the payload and deposits into a shared mailbox (generally of the structure
/User/Partner/Inbox). Sterling File Gateway is configured to pick up the file from
that mailbox, perform any needed processing, and ultimately deliver the file to a
consumer mailbox.

In the outbound scenario, Sterling File Gateway is configured to deposit a message
in a consumer mailbox which will be routed and stored in the
/User/Partner/Outbox. The partner uses an EBICS client to perform an EBICS
order file download (FDL) from the Sterling B2B Integrator EBICS Server, which
packages the payload and makes it available to the EBICS client.

To ensure appropriate Sterling File Gateway operation for EBICS inbound and
outbound transfer scenarios, routing channel templates and routing channels
require specific configurations. Routing channel templates used in EBICS scenarios
must include the configuration of provisioning facts, and routing channels using
those templates must include the specification of values for provisioning facts.
Provisioning facts are optional elements in an RCT that provide a controlled way
to customize particular routing channels within the context of a particular routing
channel template by requiring user input during routing channel creation.

EBICS Operators can search for EBICS-specific activity in the Sterling File Gateway
application and view an EBICS-centric information display. An individual activity
can be selected to retrieve additional detail about the EBICS transaction and related
messages. EBICS Operators are assigned to the EBICS/SFG Operators group.

Alternatively, EBICS Operators can search for general activity and view a
file-centric information display that includes routes and deliveries that resulted
from EBICS activity.

EBICS Operators can perform basic and advanced searches for activity initiated
with the EBICS protocol, and drill down to detail associated with each activity.

EBICS Operators can subscribe for notifications of specified EBICS events. When a
subscribed event occurs, the subscriber receives an email notification.

© Copyright IBM Corp. 2008, 2014 1



Overview

License information for EBICS
IBM provides the license files for each feature of Sterling B2B Integrator that you
purchased.

You do not have to contact IBM Customer Support to get the license files. A
separate license is required for each Sterling B2B Integrator feature that you
purchased. During installation, you must choose the license files according to what
has been purchased. IBM Customer Support will audit the system once your
system is in use. If after the installation is finished, you determine that you need to
modify licenses files, see the License Modification topic in the Sterling B2B Integrator
online library at Sterling B2B Integrator 5.2 online library for more information.

To utilize the EBICS Banking Server, you must also have an EBICS license.

System Administrator

About EBICS integration with Sterling File Gateway
Sterling File Gateway is required in order to route files to or from EBICS
Partners/Subscribers. After you install Sterling B2B Integrator with the EBICS
module, you must separately install Sterling File Gateway, and perform an
additional procedure to set up integration.

Sterling File Gateway is an application for transferring files between partners using
different protocols, file naming conventions, and file formats.Sterling File Gateway
supports movement of large and high-volume file transfers, with visibility of file
movement in a process-oriented and highly-scalable framework that alleviates file
transfer challenges, such as protocol and file brokering, automation, and data
security.

When handling EBICS transactions, Sterling File Gateway uses templates to
describe how each transaction is interpreted to determine how and where it should
be delivered and provides visibility into the details of the transfers for auditing
and troubleshooting.

Files move between the EBICS server and Sterling File Gateway using shared
partners and mailboxes. The shared mailboxes are created when EBICS partners
are created. Sterling File Gateway then uses the mailboxes for transferring files to
or from EBICS partners.

For inbound scenarios, a partner uses an EBICS client to perform an EBICS order
file upload (FUL) to the Sterling B2B Integrator EBICS Server, which unpackages
the payload and deposits it into a shared mailbox (generally of the structure
/User/Partner/Inbox). Sterling File Gateway is configured to pick up the file from
that mailbox, perform any needed processing, and ultimately deliver the file to a
consumer mailbox.

In the outbound scenario, a file (or files) is available in an EBICS partner shared
mailbox (generally of the structure /User/Partner/Outbox). The partner uses an
EBICS client to perform an EBICS order file download (FDL) from the Sterling B2B
Integrator EBICS Server, which packages the payload and makes available to the
EBICS client.
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To ensure appropriate v operation for EBICS inbound and outbound transfer
scenarios, routing channel templates and routing channels require specific
configurations. Routing channel templates used in EBICS scenarios must include
the configuration of provisioning facts and routing channels using those templates
must include the specification of values for provisioning facts. Provisioning facts
are optional elements in an RCT that provide a controlled way to customize
particular routing channels within the context of a particular routing channel
template by requiring user input during routing channel creation.

Operators can search for EBICS-specific activity in the Sterling File Gateway
application and view an EBICS-centric information display. An individual activity
can be selected to retrieve additional detail about the EBICS transaction and related
messages.

Alternatively, operators can search for general activity and view a file-centric
information display that includes routes and deliveries that resulted from EBICS
activity.

Operators can perform basic and advanced searches for activity initiated with the
EBICS protocol.

Operators can subscribe for notifications of specified EBICS events. When a
subscribed event occurs, the subscriber receives an email notification.

Role of EBICS System Administrators in Sterling File Gateway
EBICS System Administrators perform these functions:
v Install and maintain system software
v Handle functions accessed in Sterling B2B Integrator
v Create and manage initial administrative user accounts
v Configure services and adapters
v Manage extensibility features
v Move resources and configurations between systems
v Set up EBICS integration with Sterling File Gateway and Sterling B2B Integrator

Setting up an HTTP server adapter for EBICS
An HTTP Server adapter instance is used to receive the incoming EBICS requests
and will initiate a business process to start processing the EBICS transactions.

About this task

By default, an HTTP Server adapter instance (EBICS Http Server Adapter) is
auto-configured for handling EBICS requests. The HTTP Server adapter instance
has a URI mapped to the business process.

The URI /ebicsrequest is the default URI specified in the EBICS HTTP Server
Adapter. To configure a new URI:

Procedure
1. From Sterling File Gateway, select Tools > B2B Console.
2. From the Admin console, select Deployment > Services > Configuration.
3. Next to Create New Service, click Go!

4. From the tree directory, select HTTP Server Adapter and click Save.
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5. Click Next. Type a name and description for your EBICS HTTP Server Adapter
instance.

6. Click Next. Enter a port number and Total Business Process queue depth
threshold. Enter 0 for an unlimited queue depth threshold.

7. Click add next to New URI. Type the desired URI.
8. Select Business Process under Launch a BP Or WAR.
9. Set Send Raw Messages to No.

Note: The newly configured URI and the HTTP Server port number must
match the host URL of the bank's profile.

Setting up EBICS integration with Sterling File Gateway
Before you can use Sterling File Gateway to route files to or from EBICS
Partners/Subscribers, you must set up EBICS integration with Sterling File
Gateway.

About this task

To set up EBICS integration with Sterling File Gateway:

Procedure
1. From Sterling File Gateway, select Tools > B2B Console.
2. From the Sterling B2B Integrator Admin menu, select Deployment > Services

> Configuration to enable the scheduler that will be used by the EBICS Server
service for transaction housekeeping.

3. Select EBICS > Subscription Manager.
4. Select to create the following EBICS resources:
v Bank
v Partner
v User
v Offer
v Contract
v Permissions

5. Repeat Step 4 for as many partners as you want to create.
6. Close the Sterling B2B Integrator window, but do not log out, to return to

Sterling File Gateway.
7. From Sterling File Gateway, select Participants > Groups.
8. Select Add Partners and associate EBICS Partners/Subscribers with the

Sterling File Gateway All Partners group.

Note: You may see an error message that the EBICS partner does not have an
associated User Account. This does not affect the association with the group.

9. Select Routes > Templates to set up a routing channel template to use for
routing files to or from EBICS Partners/Subscribers. You must define a routing
channel template using the UserID as a provisioning fact and then reference
the UserID provisioning fact in the mailbox path for the producer, consumer,
or both, depending on how the template will be used.

Note: By adding the provisioning fact in the template, you ensure that
mailbox path structures match what was previously set up during EBICS
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Partner/Subscriber creation. If a mailbox path structure other than
/User/Partner/Inbox or /User/Partner/Outbox was specified, the template
should match that structure.

10. Select Routes > Channels to set up routing channels to use for routing files
between EBICS Partners/Subscribers.

11. Test the setup by accessing an EBICS client, log in as the EBICS
Partner/Subscriber, and send an EBICS order.

12. Select Routes > Activity.
13. Select the EBICS Partner/Subscriber from the Producer menu.
14. Click Find.
15. Look for the transfer initiated in Step 10 and select the row to view details.
16. Select the message ID hyperlink to view the route details and link to

dataflows and communication sessions in the B2B Console.

About EBICS Event Codes (Version 2.2.2 or Later)
Each activity during the progress of a file transfer generates an event code. These
codes are displayed in the activity details to enable Partners and Operators to see
the progress and navigate to more details.

The event codes in following table are specific to EBICS transactions:

Event Code Name Description
Subscription
Setting

EB_0001 InitRequestReceived Initialization Request is received No

EB_0002 RequestValidationOK Request validation is successful No

EB_0003 NumberOfSegmentRequired Number of segment required No

EB_0004 MessageMatchingFileFormatFound Message matching with file format is
found

No

EB_0005 OrderExecutionOK Order execution is successful Yes

EB_0006 InitResponseOK Initialization Response is sent without
error

No

EB_0007 TransferRequestReceivedBegin Bank begins to receive Transfer Request No

EB_0008 TransferRequestReceived Transfer Request is received No

EB_0009 TransferResponseOK Transfer Response is sent without error No

EB_0010 AckRequestReceived Acknowledgment Request is received No

EB_0011 AckResponsePostProcessed Positive/Negative acknowledgment is
received

No

EB_0012 ForwardingToOrderDataProcessing Forwarding to Order Data Processing No

EB_0013 TransactionCompleted Transaction is completed successfully Yes

EB_0014 PSRGenerationOK PSR is generated successfully No

EB_0015 InitResponseInSegOK Initialization Response in segment is sent
without error

No

EB_0016 TransactionSegmentUnderRun The total number of segments transmitted
during transaction initialization was not
reached

No

EB_0017 HEVRequestReceived HEV Request is received No

EB_0018 ESNumberRequired Number of personal signature is required No

EB_0050 RequestValidationFailed Request validation is unsuccessful Yes
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Event Code Name Description
Subscription
Setting

EB_0051 OrderExecutionFailed Order execution is unsuccessful Yes

EB_0052 InitResponseWithError Initialization Response is sent with error
code

Yes

EB_0053 PotentialAttackDetected Potential Attack detected Yes

EB_0054 RecoveryDetected Recovery is required Yes

EB_0055 TransferResponseWithError Transfer Response is sent with error code Yes

EB_0056 AckResponseWithError Acknowledgment Response is sent with
error code

Yes

EB_0057 TransactionFailed Transaction is terminated with failure Yes

EB_0058 PSRGenerationFailed PSR generation is unsuccessful Yes

EB_0059 OrderTypeVerificationFailed Order Type verification is unsuccessful No

EB_0060 BasicOrderAttribVerificationFailed Basic Order Attribute verification is
unsuccessful

No

EB_0061 ReplayTestFailed Replay Test is unsuccessful No

EB_0062 InvalidTechSubscriber Technical Subscriber is invalid No

EB_0063 InvalidTechSubscriberStatus Technical Subscriber status is invalid No

EB_0064 SignatureAuthenticationFailed Message Signature Authentication is
unsuccessful

No

EB_0065 InvalidSubscriber Subscriber is invalid No

EB_0066 InvalidSubscriberStatus Subscriber status is invalid No

EB_0067 BankKeysHashVerificationFailed Bank Key's Hash value verification is
unsuccessful

No

EB_0068 OrderTypeAuthorisationFailed Order Type authorisation is unsuccessful No

EB_0069 BankTechPrelimVerificationFailed Bank Technical preliminary verification is
unsuccessful

No

EB_0070 OrderAttribVerificationFailed Order Attribute verification is
unsuccessful

No

EB_0071 TransactionGenerationFailed Transaction Generation is unsuccessful No

EB_0072 TransactionIDVerificationFailed Transaction ID verification is unsuccessful No

EB_0073 TxPhaseTxStepVerificationFailed Transaction Phase and Step verification is
unsuccessful

No

EB_0074 SegmentNumberAndSizeVerification
Failed

Segment number and size verification is
unsuccessful

No

EB_0075 TransferResponseWithError2 Transfer Response is sent with error code No

EB_0101 UnpackOrderDataOK Unpackaging of Order Data is successful No

EB_0102 PackOrderDataOK Packaging of Order Data is successful No

EB_0103 OrderDataDocCreated Raw Order Data document is created for
download request

No

EB_0104 OrderDataDocPutIntoMbx Raw Order Data is put into upload
mailbox

No

EB_0105 ESDocUnpackedOK Raw ES document is unpacked
successfully

No

EB_0106 OrderParamsDocCreated Order Parameters document is created No

EB_0107 SignerInfo Signer Information No
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Event Code Name Description
Subscription
Setting

EB_0150 UnpackOrderDataFailed Unpackaging of Order Data is
unsuccessful

Yes

EB_0151 PackOrderDataFailed Packaging of Order Data is unsuccessful Yes

EB_0152 DataSegmentPreprocessingFailed Data segment preprocessing is
unsuccessful

No

EB_0154 OrderDataDecodingFailed Order Data decoding is unsuccessful No

EB_0155 OrderDataDecryptionFailed Order Data decryption is unsuccessful No

EB_0156 OrderDataDecompressionFailed Order Data decompression is
unsuccessful

No

EB_0157 ESVerificationFailed ES verification is unsuccessful No

EB_0158 OrderDataSchemaValidationFailed Order Data schema validation is
unsuccessful

No

EB_0159 OutMbxOrderDataProvisionFailed Order data Provision is unsuccessful in
outbox mailbox

No

EB_0160 OrderDataCompressionFailedOrder Order Data compression is unsuccessful No

EB_0161 OrderDataEncryptionFailed Order Data encryption is unsuccessful No

EB_0162 OrderDataEncodingFailed Order Data encoding is unsuccessful No

EB_0163 ESDocUnpackedFailed ES is failed to be validated Yes

EB_0164 ArcMbxOrderDataProvisionFailed Order data Provision is unsuccessful in
archive mailbox

No

EB_0165 SignerInvalidPermission Signer has no permission for personal
signature

No

EB_0166 SigNumberNotMatch Personal Signature is either incomplete or
more than expected

No

EB_0167 TechUserCannotIssueES Technical Subscriber cannot issue
Personal Signature

No

EB_0168 UploadMbxUnavailable Upload mailbox is not available Yes

EB_0201 NewCertificateAddedOK New subscriber's certificate is added No

EB_0202 CertificateUpdated Subscriber's certificate is updated No

EB_0203 SubscriberStatusChanged Change in Subscriber status No

EB_0204 PostBPInvokedOK Post Business Process is invoked
successfully

No

EB_0250 PostBPInvokedFailed Post Business Process is failed to be
invoked

Yes

EB_0251 CertUserValidationFailed Certificate user validation is unsuccessful No

EB_0252 CertVersionValidationFailed Certificate version validation is
unsuccessful

No

EB_0253 X509ComponentVerificationFailed X509 component doesn't exist No

EB_0254 PostBPVerificationFailed Post Business Process doesn't exist No

EB_0255 CertUpdateFailed Certificate update is unsuccessful No

EB_0256 CertIsRevoked Certificate is revoked Yes
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Integration Architect

Adding EBICS partners to the All Partners group
About this task

An EBICS partner subscriber onboarded through the Sterling File Gateway EBICS
Subscription Manager and stored as an identity is automatically associated with
the File Gateway All Partners group to be eligible for Sterling File Gateway
operations.

Using Provisioning Facts with EBICS
About this task

For EBICS operations, you add a provisioning fact to the routing channel template
to ensure that mailbox path structures match what was previously setup during
EBICS Partner/Subscriber creation. If you do not use provisioning facts, mailboxes
may not be appropriately set up to support EBICS operations. Generally, a mailbox
path structure of the format /User/Partner/Inbox or /User/Partner/Outbox is
needed to support EBICS transactions.

To define a mailbox path appropriate for EBICS operations:

Procedure
1. In the Routing Channel Template wizard, click on the Provisioning Facts tab,

and specify the following:
v Display Label - User ID
v Fact name - myUserId
v Description - Enter the User ID for the consumer mailbox.

2. Click Save to save the provisioning fact definition.
3. In the Routing Channel wizard, select a template of the form created in step 1.
4. Select the producer and consumer.
5. Save the routing channel.

Example EBICS scenarios
An example inbound EBICS scenario is:
1. An EBICS order is uploaded from an EBICS client to an EBICS server in a file

upload (FUL) function.
2. The EBICS Order Data Processor (ODP) unpackages the payload to its raw

inner .DAT format.
3. The EBICS ODP deposits the file into a mailbox of the structure

User/Partner/Inbox (according to the EBICS specification).
4. Sterling File Gateway routes the file from the mailbox for downstream

processing and ultimate delivery to the consumer according to the routing
channel (RC), which specifies the template to use for the route. The template
uses provisioning facts that established the mailbox path and user ID that were
determined for the routing channel. The details of an example template suitable
for an inbound EBICS scenario are:

Field Value

Template Name EBICSFUL
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Field Value

In the Type tab

Type Static

In the Special Characters tab

Special Characters None

In the Groups tab

Groups All Partners for producers and consumers

In the Provisioning Facts tab

Fact Name myUserId

Display Label User ID

Description The user ID of the producer

In the Producer tab

Producer Mailbox Path /${myUserId}/${ProducerName}/Inbox

Producer File Structure Click Add

Producer File Type Unknown

File name pattern as regular expression {([^_]+)_([^_]+)_(.+)([.]DAT)}

File name pattern group fact names, comma
delimited

myHostId,myFileFormat,mySuffix,
myExtension

In the Consumer tab

Delivery Channel Description Click Add

Pattern for Consumer Mailbox Path /${ConsumerName}/Inbox

If checked, mailboxes matching this pattern
may be created on demand

Do not check the box

Consumer File Structures Click Add

Consumer File Type Unknown

Consumer file name format ${myHostId}ara_${mySuffix}${myExtension}

An example outbound EBICS scenario is:
1. Sterling File Gateway routes an incoming file.
2. The file is packaged according to the EBICS configuration.
3. The file is deposited as a message in an EBICS partner's mailbox in the

structure /User/Partner/Outbox based on a routing channel, which specifies
the template to use for the route. The template uses provisioning facts that
establish the mailbox path and user ID for the routing channel. The details of
an example template suitable for an outbound EBICS scenario are:

Field Value

Template Name EBICSFDL

In the Type tab

Type Static

In the Special Characters tab

Special Characters None

In the Groups tab

Producer Group All Partners
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Field Value

Consumer Group All Partners

In the Provisioning Facts tab

Fact Name myUserId

Display Label User ID

Description The user ID of the consumer partner

In the Producer tab

Producer Mailbox Path /${ProducerName}

Producer File Structure Click Add

Producer File Type Text

File name pattern as regular expression .+

File name pattern group fact names, comma
delimited

In the Consumer tab

Delivery Channel Description Click Add

Pattern for Consumer Mailbox Path /${myUserId}/${ConsumerName}/Outbox

If checked, mailboxes matching this pattern
may be created on demand

Check the box

Consumer File Structures Click Add

Consumer File Type Text

Consumer file name format ${ProducerFilename}

4. The EBICS partner, using an EBICS client, initiates a file download (FDL)
request to the EBICS server.

5. The file in the consumer mailbox is picked up by the EBICS server.
6. The packaged file is transferred from the EBICS server to the EBICS client.

Route Provisioner

About partners for EBICS
EBICS partner subscribers are onboarded through the Sterling B2B Integrator
EBICS Subscription Manager.

Operator

Searching for EBICS transactions (2.2.0 - 2.2.4.2)
An EBICS license must be installed in order for EBICS transactions to be available
for searching.

About this task

To search for EBICS transactions:

Procedure
1. On the Basic Search or the Advanced Search page, select EBICS as the protocol

and click Find.
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2. From the Basic Search page, click on EBICS Search in the upper right corner.
3. Specify any combination of the following search criteria, as appropriate. Leave

any field blank to search for files that match all possible values of that field.

Field Description Action

Search Location The location of the tables
you wish to search.

Select from:

v Live Tables (default) - to
view active data

v Restore Tables - to view
archived business process
data that has been
restored.

Note: EBICS activity, such as
Transaction, Message, and
associated EBICS events, is
archived and can be searched
from the restore tables or live
tables. Sterling File Gateway
activity is purged, not
archived, and purged data
cannot be searched.

Bank ID (Host ID) Identifier for the bank. Type the Host ID or select
from the list.

Transaction ID Identifier for a specific
transaction.

Type the Transaction ID.

Transaction Status The status of the
transactions.

Select from the following:

v Open

v Received

v Rejected

v Pending

User ID Identifier for a specific user. Type the User ID.

Partner ID Identifier for a specific
partner.

Type the Partner ID.

Order ID Identifier for a specific order. Type the Order ID.

Order Type Type of order. Select from the following:

v FDL

v FUL

v HCA

v HCS

v HEV

v HIA

v HPB

v HPD

v INI

v PUB

v SPR

Order Status Status of the order. (Applies
only when Order Type =
FUL)

Select from the following:

v RCVD

v PDNG

v RJCT
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Field Description Action

File Format Format of file. Select from the list of
available file formats that
have been transferred.

Date (From) Documents in progress or
completed after the specified
start date.

Click on the calendar icon to
select the date to begin the
search.

Time (From) Documents in progress or
completed after the specified
start time.

Select the hour, in 24-hour
format, and minutes to begin
the search.

Date (To) Documents in progress or
completed before the
specified end date.

Click on the calendar icon to
select the date to end the
search.

Time (To) Documents in progress or
completed before the
specified end time.

Select the hour, in 24-hour
format, and minutes to end
the search.

4. Click Find to initiate the search. The Search Results tab opens and displays
results matching all of your criteria. A maximum of 1000 files is displayed. The
following default information is provided for each EBICS transaction:
v Order Status (only displayed for Order Type = FUL)
v Transaction Status
v Transaction ID
v Partner ID
v User ID
v Order ID
v Order
v File Format
v Time of Last Activity
v Mailbox Messages (click to view list of mailbox messages and links to

arrived files in a popup window.)
The following additional information is available:
v Bank ID (Host ID)
v Message ID (FUL only, link to Arrived File)
v Order Attribute
v Security Medium
v Direction
v Order Data Type
v Transaction Phase
v Total Segments
v Transaction Start
v Transaction End
v Original Transaction ID
v Process Status
v System ID
v Segment Received
v Recovery Counter
v Recovery Point
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Right-click on a column heading to change the sort order, or to show or hide
different columns.

5. Under the column for Mailbox Messages, a graphic icon is presented. When
you click on the icon, a popup window is presented with the list of mailbox
messages. If links to Arrived Files are present, click on those links to navigate
to the Arrived File details.

6. The results display the list of Arrived Files where the Arrived File protocol was
EBICS. Select a row to display a new pane with Arrived File Events and new
tabs with Routes and Deliveries.

Note: Search displays information with respect to Arrived Files only. Therefore,
if the search parameter is Protocol=EBICS, only files for which the Arrived File
protocol is EBICS, such as files resulting from an FUL transaction, are
displayed. For an FDL transaction, the Arrived File protocol is not EBICS and
the transaction will not be displayed under the search results with search
parameter Protocol=EBICS.

7. On the Event pane, click on the hyperlinks (underlined in blue font) to view
the unpackaged output documents, dataflows, order parameters, routing
channel templates, or workflows (business process details).

8. Event codes in a red font denote error conditions.

Searching for EBICS transactions (2.2.5 or higher)
An EBICS license must be installed in order for EBICS transactions to be available
for searching.

About this task

To search for EBICS transactions:

Procedure
1. From the Basic Search page, click EBICS Search in the upper right corner.
2. On the EBICS Search page, specify any combination of the following search

criteria, as appropriate. Leave any field blank to search for files that match all
possible values of that field.

Field Description Action

Search Location The location of the tables
you wish to search.

Select from:

v Live Tables (default) - to
view active data

v Restore Tables - to view
archived business process
data that has been
restored.

Note: EBICS activity, such as
Transaction, Message, and
associated EBICS events, is
archived and can be searched
from the restore tables or live
tables. Sterling File Gateway
activity is purged, not
archived, and purged data
cannot be searched.
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Field Description Action

Bank ID (Host ID) Identifier for the bank. Type the Host ID or select
from the list.

Transaction ID Identifier for a specific
transaction.

Type the Transaction ID.

Transaction Status The status of the
transactions.

Select from the following:

v Open

v Received

v Rejected

v Pending

User ID Identifier for a specific user. Type the User ID.

Partner ID Identifier for a specific
partner.

Type the Partner ID.

Order ID Identifier for a specific order. Type the Order ID.

Protocol Version Identifies the protocol
version

Select one of the following
protocol versions:

v H000

v H003

v H004

Order Type Type of order. Select the order type from
the dropdown list.

Order Status

(Applies only when Order
Type = FUL)

Status of the order. Select from the following:

v Open

v Received

v Rejected

v Pending

v Cancelled

v VEU

File Format Format of file. Select from the list of
available file formats that
have been transferred.

Date (From) Documents in progress or
completed after the specified
start date.

Click on the calendar icon to
select the date to begin the
search.

Time (From) Documents in progress or
completed after the specified
start time.

Select the hour, in 24-hour
format, and minutes to begin
the search.

Date (To) Documents in progress or
completed before the
specified end date.

Click on the calendar icon to
select the date to end the
search.

Time (To) Documents in progress or
completed before the
specified end time.

Select the hour, in 24-hour
format, and minutes to end
the search.

3. Click Find to initiate the search.
The Transaction Summary tab opens and displays results matching all of your
criteria. A maximum of 1000 files is displayed. The following default
information is provided for each EBICS transaction:
v Order Status (only displayed for Order Type = FUL)
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v Transaction Status
v Transaction ID
v Partner ID
v User ID
v Order ID
v Protocol Version
v Order
v File Format
v Last Activity
v Mailbox Messages (click to view list of mailbox messages and links to

arrived files in a popup window.)
Right-click on a column heading to change the sort order, or to show or hide
different columns.
The following columns are available but hidden by default:
v Bank ID (Host ID)
v Message ID (FUL only, link to Arrived File)
v Order Attribute
v Security Medium
v Direction
v Order Data Type
v Transaction Phase
v Total Segments
v Transaction Start
v Transaction End
v Original Transaction ID
v Process Status
v System ID
v Segment Received
v Recovery Counter
v Recovery Point

4. Under the column for Mailbox Messages, a graphic icon is presented. When
you click on the icon, a popup window is displayed with the list of mailbox
messages.
v Mailbox Message ID
v Document ID
v Document Type
v Arrived File Search

If links to Arrived Files are present, click those links to navigate to the Arrived
File details.

Note: Search displays information with respect to Arrived Files only. Therefore,
if the search parameter is Protocol=EBICS, only files for which the Arrived File
protocol is EBICS, such as files resulting from an FUL transaction, are
displayed. For an FDL transaction, the Arrived File protocol is not EBICS and
the transaction will not be displayed under the search results with search
parameter Protocol=EBICS.
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5. From the Transaction Summary tab, click any row to display the Transaction
Events pane and Message Details tab for the transaction in that row.

6. The Transaction Events pane displays the following information:
v Event Code (Event codes in a red font denote error conditions.)
v Time
v Description
Right-click on a column heading to change the sort order, or to show or hide
different columns. The Counter column is available, but hidden by default.
In the Description column, you can click the hyperlinks (underlined in blue
font) to view other information such as unpackaged output documents,
dataflows, order parameters, routing channel templates, or workflows (business
process details).

7. The Message Details tab displays the following information:
v Message Type
v Message Status
v Segment Number
v Data Flow
v Timestamp
Right-click on a column heading to change the sort order, or to show or hide
different columns.
You can click any available hyperlinks to view other information.

View Detailed EBICS Transactions
About this task

EBICS messages are a part of each transaction. It is analogous to one arrived file
having one or more routes. One transaction can have one or more messages. Once
you execute a typical transaction (FUL, FDL, for example), that has payload data,
the Messages tab will pop up to the right of the Transaction tab.

Procedure
1. On the Advanced Search page, under the Arrived File section, select EBICS as

the protocol and click Find.
2. A list of files where the Arrived File protocol is EBICS is displayed. For

example, files resulting from an EBICS FUL transaction.
3. Under the Delivery section, select the protocol and click Find. The protocols to

select from are:
v EBICS Inbound - refers to an external EBICS client contacting the EBICS

server to download the file from the delivery mailbox. This mode is for an
initiating consumer scenario.

v EBICS Outbound - not currently supported
v EBICS - includes both Inbound and Outbound

4. A list of files where the Delivery protocol is EBICS is displayed. For example,
files resulting from an EBICS FDL transaction.

5. Click on any file in the results to view the Events, Routes, and Delivery details.
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Replaying an EBICS Transaction from the Beginning of a
Transfer (2.2.0 - 2.2.4.2)

Replay a successful or a failed route to have the file transferred again from the
beginning.

About this task

To replay a route:

Procedure
1. From the Search page, enter criteria for the file to replay.
2. Click Find to initiate the search.

Note: Once activity is purged, it is no longer available in the system and will
not be found in a search that matches the criteria for it. You cannot replay
messages that have been purged.

3. On the Search Results page, right-click next to the file you want to replay.
4. You can enter a new name to rename the file for the replay. Do not use the

following characters: !%*?<>"/\|:.
5. You can add a comment about the replay. Up to 255 characters are allowed for

the comment. The selected file is replayed and added to the list of arrived files,
with a special icon to indicate it is a replay. You can replay a route any number
of times.

6. When you replay a route, the reviewed box is automatically checked.
Right-click and select Mark as Not Reviewed to remove the check.

Note: Once an EBICS transaction is replayed, the replayed activity will not be
noted as being an EBICS transaction, because the EBICS translation activity
does not take place in the replay.

Replaying EBICS Transactions from the Beginning of a
Transfer (2.2.5 or higher)

Replay successful or failed routes to have one or more files transferred again from
the beginning.

About this task

To replay a route:

Procedure
1. Use either Basic Search or Advanced Search. From the Search Criteria tab, enter

the criteria for the file or files you want to replay.
2. Click Find to initiate the search.

Note: Once activity is purged, it is no longer available in the system and will
not be found in a search that matches the criteria for it. You cannot replay
messages that have been purged.

3. To replay all files matching the search criteria:
a. Click Replay All.
b. In the Replay Arrived File pop-up, you can add a comment about the

replay. Up to 255 characters are allowed.
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c. In the Replay Arrived File pop-up, click Replay.

All files matching the search criteria, not just the ones displayed or selected,
will be replayed.
Skip the remaining steps.

4. To replay only selected files, on the Arrived File tab, select one or more files to
replay.
To select a file, click the check box in the first column to display a check mark.
To select all files, click the Header check box at the top of the column. All
selected files will display a check mark in the first column.
The Header check box will display one of the following values depending on
file selections:
v Checked - indicates all the files are selected
v Unchecked - indicates no files are selected
v Filled - indicates some, but not all, of the files are selected

If only one file is selected, the Arrived File Events will be displayed and Route
and Delivery tabs will be available.

5. Click Replay. In the Replay Arrived File pop-up:
a. If only one file was selected, you can enter a new name to rename the file

for the replay. Do not use the following characters: !%*?<>"/\|:..
b. You can add a comment about the replay. Up to 255 characters are allowed.
c. Click Replay.

Results

The selected files are replayed and added to the list of arrived files, with a special
icon to indicate it is a replay. If only a single file was selected for replay, it is
replayed when you click Replay. If multiple files were selected for replay, or if you
chose Replay All, the files are marked for replay and the actual replay occurs the
next time the FileGatewayReroute business process runs. By default, the
FileGatewayReroute business process runs every five minutes.

You can replay a route any number of times. When you replay a route, the
reviewed box is automatically checked. Right-click and select Mark as Not
Reviewed to remove the check.

Note: Once an EBICS transaction is replayed, the replayed activity will not be
noted as being an EBICS transaction, because the EBICS translation activity does
not take place in the replay.

Redelivering a Processed EBICS File (2.2.0 - 2.2.4.2)
About this task

Redeliver a successful or a failed route to have the processed file delivered again.
Only files that have had a previous delivery attempt, successful or failed, can be
redelivered.

Procedure
1. From the Search page, enter criteria for the file to redeliver.
2. Click Find to initiate the search.
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Note: Once activity is purged, it is no longer available in the system and will
not be found in a search that matches the criteria for it. You cannot redeliver
messages that have been purged.

3. In the resulting list, select the file.
4. On the Delivery tab, right-click on the delivery and select Redeliver this

Arrived File.
5. You can add a comment about the redelivery. Up to 255 characters are allowed

for the comment. The selected file is redelivered. Information about the
redelivery is added to the delivery details of the original delivery. You can
redeliver a route any number of times.

Note: Redeliveries create additional events for the original delivery, and do not
display as separate routes in the search results page.

Note: Once an EBICS transaction is replayed, the replayed activity will not be
noted as being an EBICS transaction, because the EBICS translation activity
does not take place in the replay.

Redelivering Processed EBICS Files (2.2.5 or higher)
Redeliver successful or failed routes to have one or more processed files delivered
again.

About this task

Only files that have had a previous delivery attempt, successful or failed, can be
redelivered.

To perform redelivery:

Procedure
1. Use either Basic Search or Advanced Search. From the Search Criteria tab, enter

the criteria for the file or files you want to replay.
2. Click Find to initiate the search.

Note: Once activity is purged, it is no longer available in the system and will
not be found in a search that matches the criteria for it. You cannot redeliver
messages that have been purged.

3. To redeliver all files matching the search criteria:
a. Click Redeliver All.
b. In the Redeliver Arrived File pop-up, you can add a comment about the

replay. Up to 255 characters are allowed.
c. In the Redeliver Arrived File pop-up, click Redeliver.

All files matching the search criteria, not just the ones displayed or selected,
will be redelivered. Information about the redelivery is added to the delivery
details of the original delivery. You can redeliver a route any number of times.
Skip the remaining steps.

4. To redeliver only selected files, on the Arrived File tab, select one or more files
to redeliver.
To select a file, click the check box in the first column to display a check mark.
To select all files, click the Header check box at the top of the column. All
selected files will display a check mark in the first column.
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The Header check box will display one of the following values depending on
file selections:
v Checked - indicates all the files are selected
v Unchecked - indicates no files are selected
v Filled - indicates some, but not all, of the files are selected

If only one file is selected, the Arrived File Events will be displayed and Route
and Delivery tabs will be available.

5. Click Redeliver. In the Redeliver Arrived File pop-up:
a. You can add a comment about the replay. Up to 255 characters are allowed.
b. Click Redeliver.

Results

The selected files are redelivered. If only a single file was selected for redelivery, it
is redelivered when you click Redeliver. If multiple files were selected for
redelivery, or if you chose Redeliver All, the files are marked for redelivery and
the actual redelivery occurs the next time the FileGatewayReroute business process
runs. By default, the FileGatewayReroute business process runs every five minutes.

Information about the redelivery is added to the delivery details of the original
delivery. You can redeliver a route any number of times. Redeliveries create
additional events for the original delivery, and do not display as separate routes in
the search results page.

When you redeliver a route, the reviewed box is automatically checked. Right-click
and select Mark as Not Reviewed to remove the check.

Note: Once an EBICS transaction is redelivered, the replayed activity will not be
noted as being an EBICS transaction, because the EBICS translation activity does
not take place in the redelivery.
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Notices

This information was developed for products and services offered in the US. This
material might be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some jurisdictions do not allow disclaimer of
express or implied warranties in certain transactions, therefore, this statement may
not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
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websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.

IBM may use or distribute any of the information you provide in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Director of Licensing
IBM Corporation
North Castle Drive, MD-NC119
Armonk, NY 10504-1785
US

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

The performance data and client examples cited are presented for illustrative
purposes only. Actual performance results may vary depending on specific
configurations and operating conditions.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBMproducts.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

Statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to actual people or business enterprises is entirely
coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
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IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must
include a copyright notice as shown in the next column.

© 2015.
Portions of this code are derived from IBM Corp. Sample Programs.
© Copyright IBM Corp. 2015.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

IT Infrastructure Library is a registered trademark of the Central Computer and
Telecommunications Agency which is now part of the Office of Government
Commerce.

Intel, Intel logo, Intel Inside, Intel Inside logo, Intel Centrino, Intel Centrino logo,
Celeron, Intel Xeon, Intel SpeedStep, Itanium, and Pentium are trademarks or
registered trademarks of Intel Corporation or its subsidiaries in the United States
and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

ITIL is a registered trademark, and a registered community trademark of the Office
of Government Commerce, and is registered in the U.S. Patent and Trademark
Office.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Cell Broadband Engine is a trademark of Sony Computer Entertainment, Inc. in the
United States, other countries, or both and is used under license therefrom.
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Linear Tape-Open, LTO, the LTO Logo, Ultrium and the Ultrium Logo are
trademarks of HP, IBM Corp. and Quantum in the U.S. and other countries.

Connect Control Center®, Connect:Direct®, Connect:Enterprise®, Gentran®,
Gentran®:Basic®, Gentran:Control®, Gentran:Director®, Gentran:Plus®,
Gentran:Realtime®, Gentran:Server®, Gentran:Viewpoint®, Sterling Commerce™,
Sterling Information Broker®, and Sterling Integrator® are trademarks or registered
trademarks of Sterling Commerce®, Inc., an IBM Company.

Other company, product, and service names may be trademarks or service marks
of others.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use

You may reproduce these publications for your personal, noncommercial use
provided that all proprietary notices are preserved. You may not distribute, display
or make derivative work of these publications, or any portion thereof, without the
express consent of IBM.

Commercial use

You may reproduce, distribute and display these publications solely within your
enterprise provided that all proprietary notices are preserved. You may not make
derivative works of these publications, or reproduce, distribute or display these
publications or any portion thereof outside your enterprise, without the express
consent of IBM.

Rights

Except as expressly granted in this permission, no other permissions, licenses or
rights are granted, either express or implied, to the publications or any
information, data, software or other intellectual property contained therein.

IBM reserves the right to withdraw the permissions granted herein whenever, in its
discretion, the use of the publications is detrimental to its interest or, as
determined by IBM, the above instructions are not being properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United States
export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY,
NON-INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE.
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